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  Our helpdesk is open 8am to 8pm Monday to Friday and 9am to 5.30pm Saturday, Sunday and Bank Holidays. 

Please call 0845 543 6033 for any assistance or help you may need. 
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1.0 Introduction ς Learning Pool Authoring Tool 
The Learning Pool Authoring Tool is an entry-level content creation tool designed to allow rapid development of 

eLearning materials that can be delivered from an Intranet, Internet or a standalone PC.  

It uses templates to generate electronic pages containing text, graphics and interactive elements. These pages are 

assembled into chapters and the tool automatically creates navigation systems between pages and chapters.  

The tool requires a similar level of IT skills to those required to use normal office software and most users can start 

to build material after a day of training.  

The tool has a number of powerful output options so the user can publish projects to fit with their learning needs.  

The output consists of HTML and JavaScript files for delivery in a number of settings: locally on a PC, on an Intranet, 

the Internet or through a SCORM compliant LMS.  

2.0 Using the Authoring Tool 

ELearning Module Structure 

An eLearning module created using the Learning Pool Authoring Tool will have the following structure:  

 

A module can contain a number of sections (similar to chapters in a book). Each section can contain a number of 

pages. You can add as many sections or pages as you want to a module. In a typical module, each section covers a 

different topic. 

Navigating a course 

The output of the Authoring Tool is standard HTML and JavaScript, which appears as a set of web pages viewable 

with a standard web browser, such as Microsoft Internet Explorer.  

The Authoring Tool automatically generates a top-level menu page containing hyperlinks to all of the sections, and 

the navigation links between the module pages. 

Within each section, the pages are accessed in sequence using Next and Back hyperlink buttons. There is a Menu 

hyperlink button link on each page, which links to the menu page.  
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Getting Started 
To launch the Learning Pool Authoring Tool, click the icon on your desktop. Or select Start ς Programs ς Authoring 

Tool Version 5. 

 

The Authoring Tool opens.  

 

Global Preferences  

Any settings you make here will apply to all projects you create. 

 

To set the Global Preferences for your projects. Select File ς 

Global Preferences. 

 

In the Global Preferences dialog box, you can set the 

default; 

¶ font,  

¶ design 

¶ project folder 

¶ autosave interval 

¶ number of recent files to display 

¶ background and 

¶ configuration. 
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Default Fonts 

To select the default font, click Browse. Select the font type and size from the Font dialogue box and click OK. 

Default Design 

The default design controls the colour scheme of the project output (such as the colour of the buttons). To select a 

design, click the Default Designs Drop Down menu and select a design from list. The preview box shows a preview of 

how the buttons will look. 

Autosave 

To set the Autosave interval, select the interval from the drop-down menu. It is recommended to set this to 10 

minutes when enabling the Autosave feature (disabled by default). Remember, Autosave is not a substitute for 

saving your work regularly.  

Most Recent Display 

To set the number of recent items to display, select the number from the Drop Down menu. 

Background Design 

It is also possible to choose the background images to be used in the course pages. To do this, click the Backgrounds 

button. 

 

You can select Upper, Middle and Lower designs. 

Changing the background images should be done carefully with due care paid to dimensions. Each image must have 

the same width as the others for a change to be done successfully, with the chosen width being between 750 and 

900 (the optimum being 800). 

¶ Upper Design image is used as the top banner in the published course pages. 

¶ The Middle Design image is repeated through the centre of the page. This image should optimally be 1-10 

pixels in height. Once selected, the picture shown on the page is a sample of the image repeated as it would 

be in the course. 

¶ The Lower Design image is used as the footer and the container for navigation buttons. The minimum height 

for this image is 35 pixels. 

The settings chosen in this screen will be applied to all new projects created by the user. 
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Configuration 

 

Clicking the Configuration button will open the Advanced 

Project Configuration box. This can also be accessed via 

the Tools menu. 

Standard Project, Font Colours 

 

Here you can change the colour the text in your project. 

Select the colour required and click OK. 

 

For custom colours click on the Custom tab. 

Move the sliders to achieve the desired color. Or, if you 

know the RGB value of the colour enter it in the fields 

below the slider. Click OK. 

 

If you wish to reset the colours to their original state, 

click the Defaults button. 

Remember to click OK in the Advanced Project 

Configuration box to save your changes. 
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Standard Project, Alternative Text 

 

This allows you to customize the Alternative Text 

ǘƘŀǘ ŀǇǇŜŀǊǎ ǿƘŜƴ ŀ ǳǎŜǊΩǎ ƳƻǳǎŜ ƘƻǾŜǊǎ ƻǾŜǊ ŀ 

graphic. This is also the text a screen reader will 

output for blind or partially sighted user. 

Select the button from the Drop Down list and type 

your own in the Alternative Text when Published 

field. Click OK. 

Accessible Project 

 

Here you can customise the text description of a 

particular template. Choose the template from the 

Drop Down list and list and type your own 

description in the Accessible Description for the 

Template field. Click OK. 
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3.0 Projects 

Create a New Project 

To create a new project, select File ς New Project.  

 

 

In the New Project Dialogue Box, enter the Project Name, 

Location, Project Title and Number of Initial Sections. 

 

By default, all courses will be saved ǘƻ άx:\Learning Pool\έ 

(where x is the drive letter where the authoring tool is 

installed). To change the location in which the new course 

will be created, click the  button. Then select a different 

folder from the Folder dialogue box. 

 

click OK to save the new project. 

 

 
 

The authoring tool screen is divided into two panes: 

1. The Structure Pane (L) 

2. The Edit/Preview Pane (R) 

 

In the Structure Pane, you can view the module structure and navigate to sections and pages. In the Edit/Preview 

pane, there are two tabbed pages. You select the Edit tab to add or edit information about a section or page. You 

select the Preview page to preview a section or page. 
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Entering Module Information 

General Information 

Information about the module is entered in the Project Title Description form. To access it click on the top level 

folder (Project Title) in the Edit/Preview Pane. 

Project Title 

The title you specified when creating the new module is automatically entered in the Project Title field. If you want 

to change the project title, you can select the text to edit it.  

!ǳǘƘƻǊΩǎ bŀƳŜ 

You enter the name of the author/authors of the module in this field. This information is stored within the project so 

that the author can be identified ς it does not appear on any screen. 

Front Page Title 

You enter a title for the front (or menu) page in the Front Page Title field.  The front page title will appear on the 

front/menu page only. 

Front Page Text 

You enter text for the front (or menu) page in the Front Page Text field. For example, you can enter a welcome 

message for users and give them a brief overview of the module. The front page title will appear on the front/menu 

page only. 

Adding a Logo 

You add a logo on each page of the module to personalize the material. To do this, you must have an image of the 

logo in JPG, PNG or GIF format. The recommended maximum size for the logo image is 75 to 80 pixels high. 

To add a logo image: 

1. Click Browse in the Select a Logo file section of the Project Title Description page 

2. Click Browse and navigate to the file  

3. Then select the logo and click Open 

4. Enter a text description of the image in the Text Alternative for Image field 

Resizing a Logo 

If you add a logo that is over the recommended maximum size, you can resize the logo. There are two ways to resize 

a logo: 

1. You can selecǘ ǘƘŜ ŎƘŜŎƪōƻȄ Ψ!ƭƭƻǿ ǘƘŜ ǎȅǎǘŜƳ ǘƻ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ǊŜǎƛȊŜ ƭƻƎƻ ǘƻ Ŧƛǘ ƛƴ ŘŜǎƛƎƴΩ 

2. Alternatively, you can manually resize the logo.  

 

To manually resize the logo, first select the logo dimensions.  

 

The Image Resizing dialog box opens. 
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Next, you select Image to see the Image menu. 

 

You can choose from three options: 

1. Resize Using Width 

2. Resize Using Height 

3. General Resize 

 

 

 

To resize using width, select Resize Using Width ς Snap to Recommended 

Width. 

To resize using height, select Resize Using Height ς Snap to Recommended 

Height. 

To perform a general resize, select General Resize and then select Resize to 

50% or Select Resize Percentage (this option will allow you to select the 

percentage by which you want to resize the image). 

hƴŎŜ ȅƻǳΩǾŜ ŎƘƻǎŜƴ Ƙƻǿ ǘƻ ǊŜǎƛȊŜ ǘƘŜ ƛƳŀƎŜΣ ǘƘŜ ƛƳŀƎŜ ƛǎ ǊŜǎƛȊŜŘ ǘƻ ȅƻǳǊ 

specified size. To undo a change you have made to the image size, select Image 

ς Undo. 

If ȅƻǳΩǊŜ ƘŀǇǇȅ ǿƛǘƘ ȅƻǳǊ ŎƘŀƴƎŜǎ ǘƻ ǘƘŜ ƛƳŀƎŜ ǎƛȊŜΣ ȅƻǳ Ŏŀƴ ǎŀǾŜ ȅƻǳǊ 

changes. To do this, select File ς Save. 

Although you have saved the changes, you can revert back to the previous 

version of the image. To do this, select File ς Reload Image. The original image 

is reloaded. 

 

Note on resizing logo images 

When resizing images, remember to look at how the resized image appears in the course. To do this, you can select 

File ς Preview Project to preview the course or preview the image in the Preview tabbed page. Sometimes it may be 

necessary to resize or redesign the image in a graphic design application before adding it to a course. 

Project preferences 

On the Project Title Description form, you can set preferences for the current project. This will over-write any 

preferences you previously set using Global preferences for this project only. 
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Project Font 

You can select a default font for all module pages. To set the font, carry out these steps: 

1. Click Browse in the Project Font section of the pane 

2. In the Font dialog box, select the font, font style and font size  

3. Then click OK 

Output Details 

 

The Output Details function enables you to set various 

output design details for the current project. Click Browse 

in the Output details section of the page to open the 

Output Designs Detail dialogue box. 

Design 

 

You can set the output design for the current project. To 

do this, click the Design Drop Down menu and select a 

design from the list. 

Background Design 

 

To change the background design 

for the current project, click 

Change Background. You can 

select Upper, Middle and Lower 

designs for the project. See 

Background Design for more 

details. 

Note: Any alterations will only 

apply to this project only. 
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Microsoft Page Fade 

 

The Microsoft Page Fade facility controls the transition fade 

between pages in the final output. To change the page fade, 

click the Microsoft Page Fade Drop Down menu and select a 

time frame from the drop-down list. 

To test the chosen time delay, use the Preview a Project method to move through the pages in your project. 

Audio 

 

You can add audio files to some of your module pages. To 

enable audio, select the Allow Audio Files checkbox. Click 

OK to apply the preferences to the current project. 

 

If you chose to allow audio files, a new audio button will appear at the top right-hand side of pages in the edit pane. 

 

To add audio to a page, first click the audio button to open the Attach a Sound File to this Page dialogue box. 

 

To add the audio file, first click Browse. In 

the Please Select Audio dialogue box, 

navigate to the audio file. Select the Audio 

file and click Open. Finally, click OK to 

complete. 

 

Once an audio file is added, the Listen 

button will be available on the Play Audio 

file dialogue box. Click Listen to open the 

Play Audio File dialogue box. Click Play to 

preview the audio file you added. Click OK. 

 

Once a page has an audio file attached, the audio button on the preview pane will change to reflect this: 
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Without Audio 
 

With Audio  
 

4.0 Audio Studio 
The Audio Studio allows you to record voiceovers for pages and play audio in your project.  

To open the Audio Recording dialogue box, select Tools ς Audio Studio ς Audio Record/Convert ς This Project.  

 

The Audio Recording dialogue box opens. 

 

Audio formats 

If you have numerous recordings (or a few very long recordings), it is advisable to use a different recording format to 

the default Wave (.wav) We recommend you use the widely supported MPEG Layer-3 (MP3). format. To change the 

format, 

¶ Give the recording a name in the Sound Name field 

¶ click Select Format and choose MPEG Layer-3 from the Format dropdown list 

¶ the attributes setting can be left at the default setting 

¶ click OK. 

It is possible to alter the Sample rate of the recording. This will have two affects on the quality of recording. The 

higher the Sample rate, the greater the sound. However, this will result in a larger file. If you use a high Sample rate 






































































